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¿QUÉ ES EL MAPPING?

La definición más simple podría ser: proyectar una imagen sobre una su-
perficie.

Generalmente, se asocia el mapping a aquellas experiencias que requieren 
grandes equipos y animaciones 3D. Un ejemplo podría ser el mapping que 
se hizo sobre la icónica Casa Batlló, en España.

Sin embargo, el mapping también puede ser algo mucho más minimalista, 
narrativo y hecho a una escala más pequeña como la muestra Gallery Inva-
sion Monkey.

Otro tipo de mapping puede ser en una obra de teatro. En la obra El Tasore 
de Diego Biancoto, la proyección pone en valor un elemento de la escena 
y de alguna manera genera una “realidad aumentada”. 

También, se puede hacer mapping sin PC, por ejemplo, con un proyector de 
diapositivas. 

Por todo esto, hablamos del mapping como arte escénico porque implica 
una relación con un espacio (o los objetos de dicho espacio) y considera a 
un/a  espectador/a ideal, un punto de vista privilegiado, que no impide que 
la experiencia se pueda apreciar desde otra posición). 

Esto se llama perspectiva forzada y, aunque no trabaja con proyecciones, 
el videoclip The writings on the wall de la banda estadounidense OK Go es 
un buen ejemplo de este principio.

MÓDULO 1 Videomapping y visuales escénicas

https://www.youtube.com/watch?v=oOsAexs6Bl4
https://www.youtube.com/watch?v=QKjcrtNtjs4
https://www.youtube.com/watch?v=QKjcrtNtjs4
https://www.youtube.com/watch?v=m86ae_e_ptU
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MÓDULO 2
PROYECTORES

Tipo de proyectores

· DLP (Digital Light Processing) 
Negro más profundo
Son más sensibles al calor (se queman más fácilmente) 

· LCD (Liquid Crystal Display) 
Tienen menos contraste (suele escaparse algo de luz) 
Soportan mejor el calor
Son más de batalla /en mi experiencia personal

Tipos de proyección 

La proyección puede ser de back o de front. Cada uno tiene sus ventajas y 
desventajas. 

Front
Es la forma más común de proyección. El proyector está ubicado de frente 
a la superficie sobre la que se proyecta.  
· Si se está proyectando en un concierto, va a “pintar” a los/as músicos/as 
(puede ser una búsqueda posible).
· Va a generar sombras en el fondo.
· Es importante que la proyección no coincida con zonas fuertemente ilu-
minadas por las luces del show porque ese tipo de iluminación eclipsa la luz 
del proyector.

Back
La luz del proyector sale por detrás de la superficie proyectada. 
· Evita poner el proyector en la zona del público.
· Es más prolijo y evita las sombras indeseadas, pero hay que tener en cuen-
ta que rinde menos porque una parte de la luz del proyector rebota sobre la 
superficie y por lo tanto la imagen tiene menos intensidad.
· Las figuras quedan a contraluz.
· Requiere margen atrás para el tiro del proyector.
· Es necesario dar vuelta la imagen y espejarla para que desde el público no 
se vea al revés. Los proyectores suelen tener esta función. 

Las telas translúcidas sirven para hacer de front y de back a la vez. Un 
ejemplo posible es la instalación-videoclip de Prana.

Videomapping y visuales escénicas
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MÓDULO 2

También se puede poner el proyector invertido. Esto, por ejemplo, permite 
“saltear” objetos. 
Se puede lograr debido a la forma en la que salen los haces de luz desde 
el proyector: la luz del proyector no sale como en la figura 1 con el mismo 
ángulo hacia arriba que hacia abajo. Si apoyamos el proyector en el piso, no 
se puede abrir la imagen hacia abajo. Por eso, la luz del proyector sale como 
en la figura. 2.

        

Fig. 1            Fig. 2

Teniendo presente eso, se puede invertir el proyector y colgarlo para “sal-
tear” la figura si fuera necesario como se ve en la siguiente figura.

    

Fig. 3

Videomapping y visuales escénicas
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MÓDULO 2

Cuidados del proyector 

Hay que tener cuidado al colgar los proyectores porque tienen dos rejillas, 
una por la que toman aire y otra por la que expulsan calor. Es importante 
no taparlas y, en caso de colgarlos de costado, es importante que la salida 
de aire esté hacia arriba (no hacia abajo porque como el calor sube, hay más 
posibilidades de que recaliente al equipo). 

Para manipular el proyector, siempre hay que esperar a que se enfríe. No 
manipular en caliente.

Los proyectores tienen unas pocas miles de horas de lámpara. Muchos pro-
yectores tienen “modo eco” para bajar el brillo y evitar gastar lámpara. A 
medida que se va gastando la lámpara, va perdiendo intensidad.

Hay algunos contextos que suman daño paulatino a los equipos, por ejem-
plo, el humo de bares y discotecas. 

Sacar y limpiar el filtro es una buena práctica de cuidado. Siempre es bueno 
limpiar la lente del proyector con papel tissu para asegurar que proyecte 
una imagen limpia. 

Lúmenes

Mide la potencia de la lámpara y tiene relación con la distancia a la que se 
puede ubicar el proyector. Los lúmenes se miden sobre el blanco. 

 - 2600 a 3200 lúmenes: sirve para usos domésticos/cotidianos 
 - 4000 lúmenes: buena calidad
 - 8000 a 12000 lúmenes: son equipos profesionales que en general se alquilan 

Ansilúmenes / lúmenes led: no son lo mismo. Equivalencia aproximada: 
3000 lúmenes led = 500 ansilúmenes

Proyectores con lúmenes led:
· Son más resistentes, no se queman a un mínimo golpe.
· Son más baratos.
· Sirven para distancias cortas y funciones básicas.

Videomapping y visuales escénicas
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Pixel nativo
Indica la resolución de la imagen (tamaño del píxel).
A grandes distancias, importa más la potencia que el tamaño del píxel.
A la hora de elegir un proyector, por lo general conviene priorizar los lúmenes 
por sobre los píxeles (siempre sobre una base mínima de 1024 x 768 px).

Relación entre lúmenes y distancia
La intensidad de los proyectores es inversamente proporcional al cuadrado 
de la distancia. Esto quiere decir que la intensidad baja de manera expo-
nencial cuanto más se aleja el proyector: si se aleja al doble de la distancia, 
la intensidad disminuye cuatro veces. 

Ejemplo: 
1m de distancia = 1000 lúmenes
2m de distancia = 250 lúmenes (¼ de la luz que había antes)

Nota: 1m de distancia no implica necesariamente 1000 lúmenes. Es un valor 
de ejemplo para explicar la relación entre distancia e intensidad. 

1 lux = 1 lúmen x m2 

Ejemplo: proyecto 1000 lúmenes sobre una superficie de 10m2  → no voy a 
tener más de 100 lúmenes por m2.

Videomapping y visuales escénicas
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Referencia general: 
3000 lúmenes cada 3 o 4m de ancho dependiendo la luz ambiente.

Calculadora online para estimar relación entre distancia del proyector y 
tamaño de la pantalla: projectorcentral.com

Sirve de referencia, pero siempre se recomienda hacer la prueba real en 
función de las condiciones de cada espacio específico. 

Referencia de ratio tiro/throw: 1.5  de ratio → significa que necesita 1.5m de 
distancia para un ancho de imagen de 1m.

Recomendación al comprar/alquilar un proyector: 
poner a 1m de una pared y medir el ancho de la imagen para tener                                                                   
una referencia real de lo que puede dar nuestro proyector.. 

Proyectores de tiro corto → tienen lente angular: abre mucho el ángulo a 
corta distancia.
Proyectores tiro largo → proyectores profesionales para grandes distancias.

Los proyectores domésticos en general se ubican en valores intermedios. 

MÓDULO 2 Videomapping y visuales escénicas

https://www.projectorcentral.com/
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VGA
Es analógico. Si se genera interferencia, afecta a la imagen pero se ve.

Los demás conectores son digitales
Si se genera interferencia eléctrica (por ejemplo, con una máquina de humo 
defectuosa cerca del cable hdmi), directamente no sale la imagen. 

Cuanto más largos son los cables, más posibilidades de ruido hay. Conviene 
que cuanto más largo, más grueso sea. Cercano a los 20m conviene que sea 
un cable mallado. Más de 20m de cable es riesgoso. 

Tip: unir dos cables (por ejemplo uno de 10m y uno de 20m) con un        
splitter activo en el medio. Esto hace que la señal tenga más corriente y por 
lo tanto la imagen llegue mejor.

Cables SDI
Se usan para grandes shows.

Cables composite
Soportan muy poca resolución. pierden un poco de imagen pero sirven. Se 
pueden alargar fácilmente, ideal para un video analógico.

Escalador
Recibe la señal de la PC y la adapta a la pantalla. Permite conectar varias 
entradas a la vez y switchear.

MÓDULO 2

Cables y conectores

Videomapping y visuales escénicas
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MÓDULO 3

RESOLUME

Descripción general del software

Programa de visuales en vivo que se usa para hacer VJ. 
Sirve tanto para disparar imágenes como para administrar/gestionar videos 
(media server). 

Tiene un gran motor de mapping (que actualmente es el que se considera 
como estándar en la industria, junto con madmapper). 

Hay dos versiones del programa: 

Resolume Avenue: tiene todas las funcionalidades básicas, pero sin el 
motor de mapping.

Resolume Arena: tiene SD extra, de salida avanzada para poder configurar 
y mapear la superficie. Es el que generalmente se usa. 

Es un software relativamente “barato” para lo que salen los softwares de 
este estilo. 
La versión gratuita tiene marca de agua (aparece imagen/video cada tanto) 
para evitar el uso comercial, pero sirve para practicar y aprender.

Recomendación: usar Resolume 6 y 7 porque son de 64 bits lo que permite 
cargar videos más grandes. Para pasar visuales en una fiesta o en una si-
tuación casual o informal, quizás no hay mucha diferencia, pero para videos 
de mayor resolución/peso convienen estas versiones de 64 bits  porque a 
las anteriores (que son de 32 bits) les cuesta procesar grandes materiales. 

Se puede grabar una composición y usarla como clip. ¡ATENCIÓN!: en vivo 
puede llegar a colgar la PC, depende mucho de las características de la com-
putadora, la RAM que tenga y la versión de Resolume que estén usando. 

                 El Resolume 6 no es bueno grabando.
                 El Resolume 7 mejoró muchísimo. 
                 A veces, conviene grabar en OBS. 

Videomapping y visuales escénicas
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También, requiere más capacidad de procesamiento para pasar en reversa 
algunos videos externos o grabados. Es una cuestión de códec. Sin embargo, 
no sucede lo mismo con los videos preparados para Resolume, por ejemplo, 
los que trae el programa por default o los que están en formato DXV3. 

Alley → software que viene con Resolume y permite convertir videos a 
DVX3.
Para eso, hay que arrastrar el video al Alley, se setea el formato de salida 
según las preferencias (con o sin audio, etc.) → click en queue para conver-
tirlo.

En función de la PC y la situación del mapping, puede convenir separar un 
video en varios más cortos o utilizar un video largo y más pesado.  

También se puede exportar un video o proyecto desde Media Encoder de 
Adobe. 
Se puede exportar en MP4, porque el Resolume lo va a poder leer, pero 
según la PC puede que le cueste procesarlo y se trabe. Conviene exportar 
en DVX3 aunque hay que tener en cuenta que el archivo resultante será 
bastante más pesado.

Idioma
Se puede modificar desde Vista>Lenguaje o View>Language.

Para quienes cuenten con un mínimo manejo de inglés, se recomienda 
usarlo en dicho idioma ya que al consultar foros y tutoriales, la mayoría 
nombra las funciones en inglés (incluso cuando el foro o tutorial que se 
consulte sea en español). 

Settings
Entre las principales configuraciones, se puede modificar el tamaño de la 
composición para ajustarlo el tamaño de salida al tamaño del video. 

Pantallas
La opción duplicar pantalla duplica la misma imagen en otra pantalla. 
La opción ampliar pantalla permite extender los marcos de la imagen a 
otra pantalla o superficie. 

En Escritorio>Configuración pantalla se puede chequear y modificar la 
configuración.

MÓDULO 3 Videomapping y visuales escénicas
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La función Output (salida) permite elegir si salir en una o dos pantallas.

CTRL+SHIFT+D desactiva la salida.

Splitter: permite salir con la misma señal a dos proyectores distintos. 

Buena práctica: tener fondo de pantalla en negro para evitar que aparezca 
la imagen de escritorio que viene por default.

Timeline
Línea de tiempo compuesta por distintas capas.

Algunas funciones del menú timeline: 
Timeline > menú desplegable ~ >
      Loop: termina video y empieza de nuevo
      Bounce: termina video y empieza marcha atrás
      Play and clear: termina y apaga video
      Play and hold: termina y congela imagen final
      Random: termina video y pasa a otro de manera aleatoria

Videomapping y visuales escénicas
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Capas

Es cada una de las líneas del timeline que se apilan horizontalmente. Se 
apilan de abajo hacia arriba, es decir, que lo que se ubique en una capa de 
arriba, tapará o se superpondrá a las imágenes de la/s capa/s de abajo. 

Se pueden agregar nuevas capas: Insert above.
Click sobre video para mover de una capa a otra.

En el menú que está al inicio de cada capa, se puede subir/bajar la velocidad 
de cada clip, cambiar su escala (horizontal, vertical o mantener ratio). 

Al ubicar el mouse sobre los distintos parámetros y clickear sobre el botón 
derecho del mouse se puede resetear la configuración para recuperar los 
parámetros originales. 

Botón derecho sobre la capa: permite agregar/eliminar la capa.

Se pueden manejar las transiciones desde el menú de cada capa: 
View > Show Layer > Transition control
Vista > Mostrar capa > Control de transiciones 

Aparecen unos botones al inicio de la capa con una T que se puede subir/
bajar: regula el tiempo de transición entre las imágenes. 

Recomendación: siempre conviene ponerles una mínima transición suave 
a todas las imágenes para que no haya cortes/saltos bruscos. 

Capas > add → permite elegir distintos modos. Por ejemplo, modo “diferen-
cia”: sustrae colores entre una capa y otra.

Clips

Son los distintos videos con los que trabajaremos. Se ubican en las distintas 
capas y se disparan de izquierda a derecha. 

Click sobre el clip: se dispara.
Click sobre el nombre del clip: lo abre en el panel del medio para poder mo-
dificar sus propiedades. 
Botón derecho sobre el clip > erase / eliminar: borra el clip
Se puede ajustar la velocidad del clip en vivo. 

Videomapping y visuales escénicas
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Opacidad

Se puede regular la opacidad de cada capa. Esto se controla desde la V que 
se encuentra al lado de cada capa.

Input (o entrada)

Hace referencia al material que ingresa al Resolume: fuente de ingesta, tipo 
de video, resolución, etc. Permite marcar qué zona de la imagen que está 
entrando queremos usar. 

Output (o salida)

Hace referencia a lo que va a salir por el proyector.

Output > Show test card (mostrar carta de prueba): sirve para calibrar la 
imagen. 
Incluye un círculo que sirve como referencia para ver si la imagen está de-
formada o no. Las líneas diagonales sirven como referencia para ajustar la 
pantalla, llevando la línea diagonal hasta el vértice de la pantalla.

Transformación de salida, permite ajustar la imagen punto por punto.

Videomapping y visuales escénicas
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Panel del medio

Es uno de los paneles desde donde se pueden controlar varias funciones.

Por defecto tiene 3 pestañas: 

· Composición: permite ver cómo va a salir la imagen final
· Layer: permite ver una determinada capa
· Clip: permite ver cada clip (video) individualmente

Si se aplican filtros o efectos sobre estas pestañas, afectarán a toda la com-
posición, la capa o sólo el clip, según la pestaña sobre la que se aplique.

Panel derecho inferior

Archivo: permite examinar.
Composición: se puede guardar.
Deck: acceso rápido de archivos.

Source > Generadores > Shapers: videos con formas y efectos que trae el 
programa

Videomapping y visuales escénicas
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Efectos

Hay dos formas de agregar efectos: 
1. Arrastrar directamente el efecto hasta un clip del timeline.
2. Pararse (click) sobre un clip en el timeline y arrastrar el efecto hasta el 
panel del medio> pestaña Clip.

Nota: si el panel está abierto en pestaña composición, el efecto se aplica a toda 
la composición. Si el panel está abierto en pestaña layer/capa, el efecto se aplica 
a la capa que esté seleccionada. Esto puede ser útil para agregar un efecto a 
varios clips en simultáneo sin tener que hacerlo uno por uno. Sin embargo, hay 
que tener en cuenta que cuando el efecto está aplicado a un clip, si se cambia 
el clip de capa, ese clip va a seguir teniendo el efecto. Pero si el efecto se aplica 
a una capa, al quitar un clip de esa capa y moverlo a otra, el clip ya no tendrá el 
efecto (porque el efecto está aplicado a la capa, y no al clip).De la misma ma-
nera, si un efecto está aplicado sobre la composición entera estará afectando a 
todos los clips y todas las capas. 

El orden de los efectos se aplica de arriba hacia abajo. 

Por ejemplo: ponemos un efecto A y luego agregamos un efecto B: B se va 
a aplicar sobre la imagen resultante del efecto A. Si se ponen en el orden 
inverso (primero B y luego A), el efecto A no se va a aplicar sobre la imagen 
original sino sobre la imagen ya modificada por el efecto B.

En el caso de algunos efectos, el cambio de orden puede generar resultados 
muy distintos.

Videomapping y visuales escénicas
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MAPPING

Máscaras
El uso de máscaras es una de las principales estrategias a la hora de hacer 
mapping. 

Una máscara es un filtro que permite a la luz pasar por algunos sectores y 
no por otros. Las partes blancas de la máscara dejarán pasar la luz mientras 
que las partes negras de la imagen no permitirán pasar la luz. 

Se puede aplicar a una o varias capas. También, se pueden utilizar distintas 
máscaras para distintas capas. 

Es recomendable setear igual todos los videos que se proyecten sobre una 
misma superficie de modo de poder usar la misma máscara para todos. 
Esto permite ajustar la máscara una sola vez y, luego, si se reemplaza el 
video, este quedará ajustado.

Grillas
Si un espacio tiene una superficie de proyección con una forma singular y 
se va a proyectar sobre eso más de una vez, conviene armar una grilla que 
esté mapeada de antemano. Esto permite evitar ajustar la imagen cada 
vez o, incluso, poder pasarle la grilla a distintos/as VJs y ahorrar tiempo y 
trabajo. Es algo muy útil en caso de festivales ya que permite enviar de an-
temano la grilla a diferentes VJs y no sólo ahorrarles tiempo y trabajo, sino 
asegurar que todas las visuales se ajusten al espacio.

Si el proyector no está desde el mismo punto de vista que el público, se 
puede mapear con grilla o con slices para acomodar cada elemento por 
separado y que parezca que la imagen viene de frente cuando en realidad 
está viniendo de costado.

Fuentes de entrada externas
Se puede alimentar la proyección con señales provenientes de otras fuen-
tes de entrada: 

• Webcams: se puede tomar como fuente de imagen desde el panel de 
fuentes.
• Teléfonos móviles: se pueden utilizar como webcam a través de Irun o 
Droidcam.

Videomapping y visuales escénicas
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• Processing: permite crear visuales a partir de código de diseño generati-
vo y conectarlo con Resolume a través del plug-in Spout.
• Hydra: similar a Processing, permite crear visuales pero con live coding. 
También requiere el uso de un tercer programa, como el OBS que envíe por 
spout el navegador.
• TouchDesigner: permite crear visuales de diseño generativo, no requiere 
escribir código pero sí funciona con lógica de programación. Al igual que 
Hydra y Processing requiere la utilización del plug-in Spout para conectarlo 
a Resolume. La versión gratuita de TouchDesigner tiene como limitación 
una resolución de 1280x720.

Javier Casadidio (@yoperro) es un buen referente de TouchDesigner. En 
sus redes comparte tutoriales para aprender a utilizarlo.

Herramientas intermediarias 

Para tomar señal en Resolume de alguna de estas fuentes, es necesario 
utilizar algunas herramientas intermediarias.

OBS
Es un programa para hacer captura de pantalla o streaming (por ejemplo, 
a través de Twitch). Requiere el plugin de spout para poder enviarle video 
a Resolume 

Spout
Es un plug-in que se puede descargar e instalar fácilmente googleando 
“spout obs plug in”. Permite salir de la lógica del loop y trabajar con diná-
micas más creativas como diseño generativo. 

NDI
Es un protocolo que comprime video y lo envía por cable de red.Cumple una 
función similar a Spout permitiendo conectar dos PC o varios programas 
dentro de una misma PC. Para utilizarlo, es necesario descargar NDI Tools 
(no NDI Core). Es gratuito y fácil de instalar, sólo pide un registro de usua-
rio. Tiene una latencia casi imperceptible. Está pensado para utilizarse con 
cable de red. Si se lo utiliza con wi-fi puede tener más latencia. 

Videomapping y visuales escénicas
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Principales funciones: 
Screen capture: captura la pantalla y envía la imagen a cualquier otro pro-
grama. 
Studio monitor: permite monitorear lo que se ve. Permite enviar señal de 
una PC a otra, o dentro de una misma PC. Es por esto que representa otra 
manera de conectar dos programas. También se puede vincular con After 
Effects y Premiere con Resolume. Y tiene la posibilidad de generar patterns 
para proyectar. 

NDI es más pesado que Spout. Requiere comprimir y descomprimir el video 
para poder enviarlo por cable de red. 

Varias de estas herramientas se pueden combinar. Por ejemplo: se puede 
enviar una textura por NDI y que el VJ convierta eso en una proyección so-
bre un objeto a través utilizando TouchDesigner.

MIDI
También se puede manejar Resolume desde un controlador MIDI y manejar 
desde una consola física las entradas y salidas de imágenes, efectos, opa-
cidad, etc.

Videomapping y visuales escénicas
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Lisando Peralta es un artista multimedial, especializado en la producción en el 
área de las visuales escénicas. Se desempeña mayormente en el diseño, ejecución, 
programación, y montaje de obras de arte tecnológico/ interactivas, instalaciones, 
mapping, etc.
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